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Загальні положення 

Метою виконання лабораторних робіт є здобуття знань про сучасні 

методи розрахунку ґрунтових гідротехнічних споруд за допомогою 

комп’ютерного моделювання, оволодіння загальними принципами 

моделювання процесів у насипах, виїмках та ґрунтах. 

З урахуванням специфіки гідротехнічних споруд студенти мають 

набути знання та навички використання програмного забезпечення для  

розрахунку фільтрації, стійкості укосів та осадження насипних  

гідротехнічних споруд. 

Виконання лабораторних робіт дасть змогу студентам у результаті 

наочного спостереження за результатами моделювання краще засвоїти 

теоретичні знання,  отримані в лекційному курсі. 

Лабораторні роботи виконуються на програмному комплексі 

GeoStudio і оформлюються в форматі А4, результати розрахунків також 

можуть бути внесені в атестаційну роботу. 

У розділах мають бути відображені такі дані: 

1. Вихідні дані для розрахунку та розрахункова схема. 

2. Теоретичні основи розрахунку. 

3. Результати розрахунків у вигляді звіту програмного комплексу 

GeoStudio. 

4. Результати розрахунку з нанесеною кривою фільтрації та 

градієнтів напору. 

5. Визначення фільтраційної витрати за допомогою побудови 

графіку в ПК Seep/W. 

6. Визначення стійкості низового укосу. 

7. Визначення вертикальних деформацій основи греблі. 

1. Теоретичні основи розрахунків кривої фільтрації 

В основу розрахунків на ПК Seep/W покладено закон Дарсі: 

𝑞 = 𝑘𝐼,      (1) 

де q – питома витрата крізь переріз, м
3
/(с·м); k – коефіцієнт фільтрації, м/с; 

I – градієнт напору. 

Основне диференційне рівняння усталеного фільтраційного потоку 

(рівняння нерозривності) в двовимірних умовах має вигляд: 

𝜕

𝜕𝑥
(𝑘𝑥

𝜕𝐻

𝜕𝑥
) +

𝜕

𝜕𝑦
(𝑘𝑦

𝜕𝐻

𝜕𝑦
) = 0,     (2) 
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де Н – п’єзометричний напір, м; kx – коефіцієнт фільтрації в напрямку х, 

м/с; ky – коефіцієнт фільтрації в напрямку y, м/с. 

В умовах однорідно-ізотропних ґрунтів kx=ky рівняння (2) набуває 

вигляду: 

𝜕2𝐻

𝜕𝑥2
+

𝜕2𝐻

𝜕𝑦2
= 0.     (3) 

Для вирішення диференціального рівняння руху усталеного 

фільтраційного потоку використано метод скінченних елементів 

чотирикутної та трикутної форм. 

Більш детально ознайомитись з фундаментальними принципами 

розрахунку, закладеними в основу ПК Seep/W, можна за посиланням 

https://www.youtube.com/watch?v=UDeJGryBkN8 ( SEEP/W Session 1: 

Introduction and Fundamentals) та [4, с 171-182]. 

ПК Seep/W використовує такі моделі фільтрації ґрунту: 

 насичений/ненасичений ґрунт; 

 насичений ґрунт. 

Ґрунт в насиченому стані розташований нижче рівня ґрунтових вод 

(випадок фільтрації під спорудами). Всі пори ґрунту заповнені водою і 

об’ємний вологовміст дорівнює пористості ґрунту: 

Θ = 𝑛𝑆,       (4) 

де ϴ – об’ємний вологовміст, м
3
/м

3
; n – пористість, м

3
/м

3
; S – коефіцієнт 

насичення, S=1. 

Коефіцієнт пористості визначається залежністю: 

 𝑒 =
𝑛

1−𝑛
.      (5) 

У розрахунку фільтрації крізь  ґрунтову греблю тіло греблі перебуває 

частково в насиченому та ненасиченому стані.  

Визначення об’ємної вологоємності в ненасиченому ґрунті 

У ненасиченому водою ґрунті об’ємна вологоємність буде  

змінюватись залежно від капілярного всмоктування води порами, де 

капілярне всмоктування визначається як різниця між тиском повітря та 

води в порах. Отже вологоємність змінюється по висоті ненасиченої зони, і 

необхідно задати функцію зміни здатності ґрунту утримувати воду зі 

зміною капілярного тиску. Приклад кривої вологоємності наведений на  

рис. 1. 

https://www.youtube.com/watch?v=UDeJGryBkN8
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Рис. 1. Крива вологоємності: 

volumetric water content – об’ємна вологоємність; matric suction – капілярне 

всмоктування; 0,3 – об’ємна вологоємність (пористість) за 100 % насиченності ґрунту 

водою 

 

Отримати залежність вологоємності від капілярного тиску можливо 

в лабораторних умовах або за допомогою аналітичних методів: 

 розрахунок за гранулометричним складом ґрунту (Аубертін 2003) 

[4, c 57-58]; 

 зразків функцій, наведених в ПК [4, с 59]; 

 Фредлунда та Хінга (1994) [4, с 60]; 

 Ван Генухтена (1980) [4, с 61]. 

Метод моделювання об’ємної вологоємності за гранулометричним 

складом ґрунту (Аубертін) дозволяє розрахувати значення функції 

вологоємності на основі властивостей ґрунту. Необхідно зауважити, що 

цей метод не використовується для глинистих та суглинистих матеріалів. 

Метод враховує вміст води в ненасиченому ґрунті за рахунок капілярного 

всмоктування та  за рахунок адгезії.  

Об’ємна вологоємність визначається залежністю: 

Θ𝑤 = 𝑛(𝑆𝑐 + 𝑆𝑎(1 − 𝑆𝑐)),      (6) 
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де ϴw- об’ємна вологоємність м
3
/м

3
; n – пористість; Sc – рівень насичення 

за рахунок капілярних сил; Sa – граничний рівень насичення за рахунок 

адгезії.  

Для розрахунку за цим методом необхідно ввести дані: пористість, 

діаметр частинок ґрунту 10% та 60%, межа текучості. 

Метод зразків функцій. У програмному комплексі наведені зразки 

усереднених функцій об’ємної вологоємності для різних ґрунтів (глина, 

пісок, гравій, суглинок, супісок). 

Для розрахунку за цим методом необхідно ввести дані: пористість та 

обрати зразок ґрунту. 

Метод Фредлунда та Хінга – це аналітичне рішення, за допомогою 

якого можна визначити об’ємний вологовміст за трьома параметрами на 

основі рівняння: 

Θ𝑤 = 𝐶Ψ
Θ𝑠

{𝑙𝑛[𝑒+(
Ψ

𝑎
)
𝑛
]}
𝑚,     (7) 

де ϴw – об’ємна вологоємність м
3
/м

3
; CѰ – функція кореляції; ϴs  – об’ємна 

вологоємність в насиченому стані; е – натуральне число, 2,718;  

Ѱ – від’ємний поровий тиск, Па; a, n, m – параметри кривої. 

𝐶Ψ = 1 −
𝑙𝑛(1+

Ψ

Ψ𝑟
)

𝑙𝑛(1+
Ψ0
Ψ𝑟

)
,      (8) 

де Ѱr – поровий тиск, який відповідає залишковій кількості води: 

Ψ𝑟 = 0,86 (
𝜉

𝑒
)
1,2

𝑤𝐿
1,74

,      (9) 

де wL – межа текучості, %; ξ – константа, наближено дорівнює 402,2 см
2
. 

𝑎 = Ψ𝑖,        (10) 

𝑚 = 3,67𝑙𝑛 (
Θ𝑠

Θ𝑖
),       (11) 

𝑛 =
1,31𝑚+1

𝑚Θ𝑠
3,72𝑠Ψ𝑖,       (12) 

де Ѱi – поровий тиск, який відповідає вологоємності в точці перелому 

кривої ϴw=f(Pw); s – нахил дотичної до функції ϴw=f(Pw) в точці перелому. 

Для розрахунку за цим методом необхідно ввести дані: пористість, 

коефіцієнти a, n, m. 

Метод Ван Генухтена визначає об’ємний вологовміст за допомогою 

чотирьох параметрів на основі рівняння:  

Θ𝑤 = Θr
Θ𝑠−Θr

{1+(
Ψ

𝑎
)
𝑛
}
𝑚,     (13) 
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де ϴr  – залишковий вміст води м
3
/м

3
; a – це точка, в якій параметр n 

змінює нахил функції, 1/Па; m – параметр, який відображає кут нахилу 

нахиленої частини кривої по відношенню до нижньої пологої частини. 

Для розрахунку за цим методом необхідно ввести дані: пористість 

залишкову вологоємність, коефіцієнти a, n. 

Визначення вологопровідності в ненасиченому водою ґрунті 

У ненасиченому водою ґрунті вологопровідність (коефіцієнт 

фільтрації) також змінюється залежно від капілярного всмоктування: чим 

менше значення порового тиску (негативні значення), тим меншого 

значення набуває вологопровідність. 

Отримати залежність вологопроводності від порового тиску 

можливо за допомогою аналітичних методів: 

 Фредлунда та Хінга (1994) [5, с 68]; 

 Ван Генухтена (1980) [5, с 70]. 

Приклад кривої залежності вологопроводності від порового тиску 

наведено на рис. 2. 

Лабораторне вимірювання вологопроводності практично не 

можливо, аналітичні методи визначення функції вологопроводності 

основані на закономірності зміни об’ємної вологоємності ненасиченого 

ґрунту. 

 

 
Рис. 2. Крива вологопроводності:  
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water X-Conductivity  – вологопровідність, м/с; matric suction – поровий тиск (капілярне 

всмоктування); 0,00005м/с – вологопровідність (коефіцієнт фільтрації) за 100 % 

насичення ґрунту водою 

Метод Фредлунда та Хінга 

Метод основано на інтегруванні кривої об’ємної вологоємності. 

Основне рівняння має такий вигляд: 

𝑘𝑤 = 𝑘𝑠
∑

Θ(𝑒𝑦)−Θ(Ψ)

𝑒𝑦𝑖
𝑁
𝑖=𝑗 Θ`(𝑒𝑦𝑖)

∑
Θ(𝑒𝑦)−Θ𝑠

𝑒𝑦𝑖
Θ`(𝑒𝑦𝑖)𝑁

𝑖=1

,     (14) 

де kw – вологопровідність в ненасиченому ґрунті чи за негативного 

порового тиску, м/с; ks – вологопровідність (коефіцієнт фільтрації ) в 

насиченому ґрунті, м/с; ϴs – об’ємна вологоємність (пористість) в 

насиченому ґрунті, м
3
/м

3
; е – натуральне число, 2,718; y – змінна 

інтегрування; і – інтервал між j та N; j – мінімальне значення порового 

тиску, описане в кінцевій функції; N – максимальне від’ємне значення 

порового тиску ; Ѱ – капілярний тиск, який відповідає j-му інтервалу; ϴ` – 

перша похідна рівняння. 

 

Для розрахунку за цим методом необхідно ввести криву об’ємного 

вологовмісту та значення коефіцієнту фільтрації в насиченому стані. 

Метод Ван Генухтена 

Ван Генухтеном була запропонована формула для визначення 

залежності між водопроводністю та поровим тиском (капілярним тиском): 

𝑘𝑤 = 𝑘𝑠
[1−(𝑎Ψ(𝑛−1))[1+(𝑎Ψ𝑛)]−𝑚]

2

[(1+𝑎Ψ)𝑛]
𝑚
2

,      (15) 

де kw – водопровідність, м/с; ks – водопровідність в насиченому стані 

(коефіцієнт фільтрації); е – натуральне число, 2,718; Ѱ – від’ємний 

поровий тиск, Па; a, n, m – параметри кривої Ван Генухтена. 

Для розрахунку за цим методом необхідно ввести криву об’ємного 

вологовмісту, значення коефіцієнту фільтрації в насиченому стані та 

залишковий вологовміст. 

Більш детально ознайомитись з основами фільтрації крізь 

ненасичений ґрунт, закладеними в розрахунки на ПК Seep/W, можна за 

посиланням  https://Www.youtube.com/Watch?v=rcgfFN5U2T0&t=1213s  

SEEP/W Session 3: Material Properties. 

https://www.youtube.com/watch?v=rcgfFN5U2T0&t=1213s
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2. Вимоги щодо фільтраційних розрахунків згідно з нормативними 

документами України 

Згідно з [1] фільтраційні розрахунки тіла греблі та основи варто 

виконувати для: 

 визначення фільтраційної міцності тіла греблі; 

 розрахунків стійкості укосів греблі; 

 обґрунтування економічних об’ємів тіла греблі та 

протифільтраційних пристроїв. 

У результаті фільтраційних розрахунків необхідно отримати 

значення: 

 положення кривої фільтрації в тілі греблі; 

 фільтраційної витрати крізь греблю; 

 градієнтів напору в тілі греблі та основі. 

Розрахунки усталеної фільтрації низового укосу необхідно 

виконувати для випадків: 

1. Рівень води у верхньому б’єфі (ВБ) відповідає НПР 

(нормальному підпірному рівню), в нижньому б’єфі (НБ) – максимально 

можливий за НПР; 

2. Рівень води у верхньому б’єфі НПР, у нижньому – 

максимально можливий за розрахункової витрати; 

3. Рівень води у верхньому б’єфі – ФПР (форсований підпірний 

рівень), у нижньому – максимально можливий за перевірочної витрати. 

Лабораторна робота 1. Визначення положення стаціонарної 

фільтрації в тілі греблі та визначення питомої фільтраційної витрати. 

Послідовність розрахунку кривої фільтрації на ПК Seep/W 

За посиланням https://www.geoslope.com/learning/downloads 

необхідно завантажити ПК GeoStudio та обрати студентську версію. 

Відкриваємо новий файл (кнопка New) або вже існуючий файл 

(кнопка Open) (рис. 3). 

https://www.geoslope.com/learning/downloads
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Рис. 3. Стартове вікно ПК GeoStudio 

 

Призначаємо формат креслення А4, за допомогою кнопки Add 

обираємо геометрію 2D, називаємо геометрію «гребля» та за допомогою 

кнопки Add обираємо програму розрахунку фільтрації Seep/W і режим 

стаціонарної фільтрації Steady-State Seepage (рис. 4). На жаль, режим 

нестаціонарної фільтрації, який використовується для розрахунку 

верхового укосу на різке пониження рівня води в водосховищі, не входить 

в студентську версію. 

 
Рис. 4. Визначення програми та режиму фільтрації 
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Обираємо одиниці виміру в системі СІ (вага в кг, довжина в метрах, 

сила в кН, температура град С і т.і.) за допомогою верхнього меню  

View → Unit (рис. 5). Тільки після цього можна креслити систему 

координат: Х – ширина греблі, Y – висота греблі. 

 
Рис. 5. Призначення одиниць виміру та встановлення системи координат 

 

Креслення перерізу греблі виконується за допомогою Меню Draw → 

Regions, обираємо форму області побудови полігональну (Polygonal) 

(рис.6). Початок креслення – координата (0;0).  

 
Рис. 6. Креслення перерізу греблі 
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Рівень води в нижньому та верхньому б’єфах, трубчастий дренаж 

задається точкою із меню Draw → Points (рис. 7). 

  
Рис. 7. Визначення рівнів води НБ та ВБ за допомогою точок 

 

Наступним кроком є визначення матеріалу тіла греблі. Обираємо 

Меню Define → Materials, за допомогою кнопки Add додаємо матеріал, 

наприклад, пісок, обираємо режим насичення водою для тіла греблі 

Saturated/ Unsaturated, для основи – Saturated (за необхідності при 

водопроникній основі). За допомогою кнопки Vol. Water Content Fn 

приймаємо функцію залежності об’ємного вологовмісту від порового 

тиску в ненасиченому ґрунті  (рис. 8). Для цього натискаємо … 
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Рис. 8. Призначення матеріалу 

 

У розрахунковій роботі обираємо метод визначення функції за 

зразковими функціями. Для цього кнопкою Add додаємо функцію з 

назвою, наприклад, «пісок», обираємо Vol. WC Data Point Function, та 

натискаємо кнопку Estimate. У відкритому вікні обираємо визначення 

функції за зразковими (Sample functions), задаємо значення пористості 

(Saturated WC),  обираємо зразок функції, яка відповідає типу ґрунту тіла 

греблі, натискаємо ОК. У правій частині відкритого вікна виділяємо пункт 

Edit Data Points. Закриваємо вікно (Close) (рис. 9). У вікні вибору матеріалу 

напроти Vol. Water Content Fn  обираємо функцію, яку ми призначили. 
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Рис. 9. Призначення функції залежності об’ємного вологовмісту від порового тиску в 

ненасиченому ґрунті 

 

За допомогою кнопки Hyd. Conductivity Fn приймаємо функцію 

залежності водопровідності від порового тиску в ненасиченому ґрунті  

(рис. 10). Для цього натискаємо … 

 
Рис. 10. Призначення функції залежності водопровідності від порового тиску в 

ненасиченому ґрунті 
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У розрахунковій роботі обираємо метод визначення функції за 

моделлю Ван Генухтена. Для цього кнопкою Add додаємо функцію з 

назвою, наприклад, «пісок фільтрація», обираємо Hyd. K Data Point 

Function та натискаємо кнопку Estimate. У відкритому вікні обираємо 

визначення функції Ван Генухтена (Van Genuchten), задаємо значення 

об’ємної вологоємності (Vol. Water Content Fn), яке вже визначено (пісок), 

коефіцієнта фільтрації (Saturated Kx), значення залишкової вологоємності 

(Residual water content), якщо величина не відома, приймаємо 10% від 

пористості, натискаємо ОК. У правій частині відкритого вікна виділяємо 

пункт Edit Data Points. Закриваємо вікно (Close) (рис. 10). У вікні вибору 

матеріалу напроти Hyd. Conductivity Fn обираємо функцію, яку ми 

призначили (пісок фільтрація) та закриваємо вікно (Close). 

Прив’язка матеріалу греблі відбувається в Меню Draw → Materials. У 

вікні обираємо необхідний матеріал і клікаємо мишкою по області 

рисунка. 

Визначення граничних умов розрахунку відбувається в Меню Define 

→ Boundary Conditions. Граничними умовами розрахунку є наявність 

напору води в верхньому (нижньому) б’єфі та поверхня витоку кривої 

фільтрації на низовий укіс, за наявності дренажу – дренаж.  

Рівень води в верхньому (нижньому) б’єфі задається як загальний 

напір (Water Total Head) та вказується значення напору в м (рис. 11). 

Виток на низовий укіс задається як витрата води (Water Rate) з 

нульовим значенням і відмічається пташкою поверхня витоку (Potential 

Seepage Face Review) (рис. 12). 

Прив’язка граничних умов відбувається в Draw → Boundary 

Conditions. У вікні обираємо необхідні граничні умови у вигляді лінії та 

кліком по лінії укосу призначаємо граничні умови (рис. 13).  

Граничні умови трубчастого дренажу задаються точкою (Point).  
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Рис.11. Граничні умови для рівня води в верхньому (нижньому) б’єфі 

 

 
Рис. 12. Граничні умови для поверхні витоку 
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Рис. 13. Прив’язка граничних умов 

 

Після призначення граничних умов можна виконувати розрахунок, 

для чого у вікні Solve Manager відмічаємо необхідний розрахунок пташкою 

та  натискаємо кнопку Start (рис. 14). Через деякий час у вікні з’явиться 

результат розрахунку кривої фільтрації. 

 
Рис. 14. Розрахунок кривої фільтрації 

 

Відеоприклади розрахунку усталеної фільтрації наведені за 

посиланнями: 

Однорідна гребля: 

https://drive.google.com/open?id=14Zl1tnU3M9NDyupcvKzVCvZaSbj6JZcY. 

https://drive.google.com/open?id=14Zl1tnU3M9NDyupcvKzVCvZaSbj6JZcY


19 

Гребля з дренажною призмою: 

https://drive.google.com/open?id=1wE7ZjtnNPGblzepezQSoKK8SwvaOpvOt. 

Гребля з ядром: 

https://drive.google.com/open?id=1c_53hVPnjASO__W_jGXptdZWUuDBo1_I. 

Гребля з екраном: 

https://drive.google.com/open?id=1WMXopDjtQ4U25o9s92xuNhtT82xUaJs1. 

Аналіз результатів розрахунків 

Розрахунок закінчується виведенням на екран результатів у вигляді 

греблі з контурами: рівних напорів; порового тиску; гідростатичного 

напору. При натисканні Page Layout   отримаємо креслення для друку.   

Створити додатковий контур (градієнти) можливо за допомогою меню 

Draw Contours (рис. 15).  

  
Рис. 15. Створення контуру градієнтів 

 

За допомогою клавіші Add додаємо додатковий контур «Градієнти», 

обираємо категорію Витрата (Water flow) та параметр Градієнт XY (Water 

XY – Gradient). Для відображення значень контуру відмічаємо пташкою 

поле Показувати легенду (Show legend). 

Для відображення поверхні кривої фільтрації (контур нульового тиску 

води) необхідно відкрити Draw Isolines і додати ізолінію  Тиску води 

(Water Pressure), категорію Поровий тиск (Pore- Pressure)  параметр Тиск 

води (Water Pressure) та внести значення (Value) 0 кПа (рис. 16). 

https://drive.google.com/open?id=1wE7ZjtnNPGblzepezQSoKK8SwvaOpvOt
https://drive.google.com/open?id=1c_53hVPnjASO__W_jGXptdZWUuDBo1_I
https://drive.google.com/open?id=1WMXopDjtQ4U25o9s92xuNhtT82xUaJs1
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Рис. 16. Відображення поверхні кривої фільтрації 

 

Інформацію щодо витрати, градієнтів, швидкості руху потоку, 

порового тиску, напорів тощо для кожної одиниці розрахункової сітки та в 

вузлах сітки можливо отримати за допомогою меню Вид Результати (View 

Result Information), вказавши вузол чи сітку (рис. 17). 

Інформацію про втрати напору на фільтрацію через переріз греблі 

(м
3
/с·м) або через укіс тіла греблі отримують за допомогою меню 

Малювання → Графік (Draw graph) чи іконки Графік (Graph) (рис. 18). 

Додаємо необхідний параметр, наприклад, «Витрата», опція Витрата 

(Water Flow – Water Rates), вісь x «час» (Time). Для визначення місця, в 

якому необхідно визначити витрату, натискаємо кнопку Встановити 

місцезнаходження (Set Locations). У новому вікні з’явиться можливість 

обрати геометричний параметр (схил чи певний елемент конструкції у 

вигляді лінії чи точки) Subdomain and Location → Geometry Items, або 

довільний переріз, накреслений за допомогою миші Subdomain Cross 

Section. Після обрання положення перерізу для розрахунку натискаємо 

кнопку Показати графік (Show Graph), на графіку відобразиться точка з 

координатою «у» зі значенням витрати (знак «мінус» означає, що витрата 

виходить із поверхні чи вузла). За допомогою кнопки Ще (More) можливо 

зберегти графік у вигляді рисунка (Copy Graph Imаge), передати дані у 

формат Exel  (Copy Graph Data), змінити одиниці виміру для графіка та 

інше. 
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Рис. 17. Інформація у вузлах сітки 

 

 
Рис. 18. Послідовність визначення фільтраційних втрат у тілі греблі 

 

За допомогою меню Ескиз (Sketch) можливо робити написи, 

домалювати необхідні пояснення, зробити написи, поставити розміри 

споруди.  

Видалення чи зміна графічних зображень здійснюється за допомогою 

меню Модифікація (Modify).  

Друк та збереження звіту виконується в меню  Вид →Звіт  

(View →Report).  
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Відео щодо аналізу результатів розрахунку можливо подивитись за 

посиланням: https://drive.google.com/open?id=1oe_NHLNs5WV-RTQ2uL4e 

OS15seHX7-Oh. 

Більше інформації знаходиться на сайті https://Www.geoslope.com та 

за посиланнями [3–9] . 

Лабораторна робота 2. Визначення епюри фільтраційного тиску 

під бетонною греблею 

Послідовність розрахунку кривої фільтрації на ПК Seep/W 

Створюємо новий файл, призначаємо формат креслення А4, за 

допомогою кнопки Add обираємо геометрію 2D, називаємо геометрію 

«бетонна гребля», за допомогою кнопки Add обираємо програму 

розрахунку фільтрації Seep/W і режим стаціонарної фільтрації Steady-State 

Seepage. Змінюємо одиниці виміру на CI (рис. 5). Створюємо геометрію 

бетонної греблі (рис. 6). Для споруд (бетонна гребля) та пристроїв 

(шпунти), які є умовно водонепроникними, створюється умовна форма 

методами малювання. Оскільки нам необхідно змоделювати рух рідини під 

спорудою, то нижня частина бетонної споруди, яка контактує з ґрунтом, 

виконується точно в розмірах згідно зі схемою розрахунку фільтрації під 

бетонною спорудою за допомогою Draw – Polygonal. Шпунти 

моделюються як суцільна з греблею тонка стінка (рис. 19). 

Створюється тільки матеріал основи Material Model: Saturated Only, 

задаємо значення об’ємної вологоємності (Sat Vol. Water Content), яке 

дорівнює пористості ґрунту, коефіцієнта фільтрації (Saturated X-

Conductivity) аналогічно рис. 8. Призначаємо матеріал основи через Draw – 

Materials.  

Граничними умовами для даного розрахункового випадку є рівень 

води в верхньому і рівень води в нижньому б’єфах. Призначаємо рівні 

води аналогічно описаному вище (рис. 11). Прикладаємо граничні умови 

на горизонтальні поверхні землі перед понуром бетонної греблі та в кінці 

бетонної греблі (рис. 20).  

Виконуємо розрахунок усталеної фільтрації. 

https://drive.google.com/open?id=1oe_NHLNs5WV-RTQ2uL4e%20OS15seHX7-Oh
https://drive.google.com/open?id=1oe_NHLNs5WV-RTQ2uL4e%20OS15seHX7-Oh
https://www.geoslope.com/
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Рис.19. Створення геометрії підземного контуру споруди 

 

 
Рис.20. Створення граничних умов напору в верхньому і нижньому б’єфах 

 

Аналіз результатів розрахунків 

Для аналізу результатів розрахунку фільтрації під бетонною спорудою 

нам необхідно створити додатковий контур (градієнти) за допомогою 

меню Draw Contours (рис. 15), для оцінки градієнтів на вході в основу, біля 

шпунтів та на виході в кінці греблі (рис. 21). 
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Рис. 21. Визначення градієнтів напору 

 

Епюру фільтраційного тиску будуємо за допомогою Draw Graph за 

методикою, описаною на рис. 18.  

 
Рис. 22. Побудова епюри фільтраційного тиску 

 

Додаємо Add графік Тиск, вказуємо розташування по осі Х Set  

Location – Geometry Items, виділяємо поверхню контакту споруди з 

ґрунтом (рис. 22). Тип графіка Pore-Pressure – Water Pressure  vs. X. Щоб 

скопіювати дані в Excel натискаємо кнопку More і обираємо Copy Graph 

Data, вставляємо дані в Excel, отримаємо сумарну епюру фільтраційного 

тиску та сили Архімеда. 
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3. Теоретичні основи розрахунків стійкості укосу 

За допомогою ПК GeoStudio: Slope/W розраховує коефіцієнт запасу 

стійкості методами граничної рівноваги: Спрощеною (Філленіуса), Бішопа, 

Янбу, Спенсера, Моргенстена-Прайса та ін.; та використовуючі метод 

скінченних елементіів, метод редукції SRM. Поверхня ковзання може бути 

круглоциліндричною або плоскою (для скельних основ). Різниця між 

методами полягає в силах, які використовуються для розрахунку рівноваги 

відсіку, та взаємозв’язку між внутрішніми силами та нормаллю до 

поверхні ковзання. 

Спрощений метод (Ordinary Method) 

 

Рис. 23. Сили, що діють на відсік, згідно зі Спрощеним методом 

 

Спрощений метод (рис. 23) історично перший метод, який не враховує 

сили взаємодії між відсіками та враховує рівність моментів зовнішніх сил 

ваги, парового тиску та тертя. Коефіцієнт стійкості укосу розраховується 

за формулою: 

𝑘 =
∑{𝑐𝑙+𝑡𝑎𝑛𝜑(𝐺𝑐𝑜𝑠𝛼−𝑢𝑙)}

∑𝐺𝑠𝑖𝑛𝛼
,     (16) 

де k – коефіцієнт стійкості укосу; с – питоме зчеплення, кПа; l – довжина 

дуги ковзання, м; G – вага відсіку, кН; α – кут нахилу відсіку до горизонту; 

φ – кут внутрішнього тертя; u – поровий тиск, кПа. 

Значення коефіцієнту стійкості укосу має занижені значення. 

Метод Бішопа 

Метод Бішопа (рис. 24) оснований на рівнянні рівноваги моментів та 

рівнянні горизонтальних сил (нормальних до поверхонь відсіку) і не 

враховує взаємодію вертикальних (зсувних) сил взаємодії між відсіками. 

Коефіцієнт стійкості укосу розраховується за формулою: 

𝑘 =
∑{𝑐𝑏+𝑡𝑎𝑛𝜑(𝐺−𝑢𝑏)}/𝑚𝑎

∑𝐺𝑠𝑖𝑛𝛼
,     (17) 
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𝑚𝑎 = (1 +
𝑡𝑎𝑛𝛼∙𝑡𝑎𝑛𝜑

𝑘
) 𝑐𝑜𝑠𝛼,     (18) 

де b – ширина відсіку, м. 

Коефіцієнт стійкості укосу згідно з рівняннями (17) і (18) є нелінійним 

і для його розрахунку необхідно використовувати ітераційний метод.   

 
Рис. 24. Сили, що діють на відсік, згідно з методом Бішопа 

 

Метод Янбу 

Метод Янбу подібний до методу Бішопа щодо врахування 

горизонтальних сил взаємодії між  відсіками, але цей метод враховує 

тільки рівновагу суми горизонтальних та вертикальних сил та не враховує 

рівняння рівноваги моментів сил (рис. 25). 

 

 
Рис. 25. Метод Янбу 

Коефіцієнт стійкості укосу розраховується за формулою: 

𝑘 =
∑𝑏∙𝑠∙𝑠𝑒𝑐2𝛼

∑(𝐺+𝑑𝑇)𝑡𝑎𝑛𝛼
,      (19) 

𝑠 =
{𝑐+(

𝐺+𝑑𝑇

𝑏
−𝑢)𝑡𝑎𝑛𝜑}

1+𝑡𝑎𝑛𝛼∙𝑡𝑎𝑛𝜑/𝑘
,     (20) 
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де secα=1/cosα; dT – різниця сил зсуву між двома сусідніми відсіками, яка 

приймається рівною нулю.   

Метод Спенсера  

За цим методом приймається рівновага сил, включаючи горизонтальні 

та вертикальні сили взаємодії між відсіками (рис. 26), та моментів сил, що 

діють на відсік.  

Спенсер запропонував розгляд двох коефіцієнтів стійкості: для 

рівняння моментів та для рівняння рівноваги горизонтальних сил. Для 

врахування горизонтальних та вертикальних сил взаємодії між відсіками 

було прийнято постійне значення співвідношення цих сил: 

𝑋 = 𝐸𝜆𝑓(𝑥) ,     (21) 

де Х – зчеплення між відсіками (вертикальна сила), кН; Е – нормальна сила 

(горизонтальна), кН; λ – коефіцієнт пропорційності функції; f(x) – функція 

от х. 

Коефіцієнт стійкості відносно моментів рівноваги: 

𝐹𝑚 =
∑(𝑐𝑙𝑅+(𝑁−𝑢𝑙)𝑅𝑡𝑎𝑛𝜑)

∑𝐺𝑥−∑𝑁𝑓∓∑𝐷𝑑
,      (22) 

Коефіцієнт стійкості відносно рівноваги горизонтальних сил: 

𝐹𝑓 =
∑(𝑐𝑙∙𝑐𝑜𝑠𝛼+(𝑁−𝑢𝑙)𝑡𝑎𝑛𝜑∙𝑐𝑜𝑠𝛼)

∑𝑁𝑠𝑖𝑛𝛼−∑𝐷𝑐𝑜𝑠𝜔
  ,    (23) 

де с – коефіцієнт зчеплення; φ – кут внутрішнього тертя; u – поровий тиск, 

кПа; N – нормальна сила, кН; G – вага відсіку, кН; D – сконцентроване 

навантаження в точці, кН; l – довжина кривої ковзання, м; R – радіус 

ковзання, м; α – кут нахилу відсіку до горизонту, град; w – кут нахилу 

сконцентрованого навантаження до горизонту, град; d – перпендикуляр, 

опущений з центра ковзання на сконцентроване навантаження, м;  

f – перпендикуляр, опущений з центра ковзання на нормальну силу, м;  

х – горизонтальна відстань від центра ковзання до осі відсіку, м. 

 
Рис. 26. Сили, що діють на відсік, за методом Спенсера 



28 

Метод Моргенстена-Прайса 

Цей метод враховує вертикальні та горизонтальні сили внутрішньої 

взаємодії між відсіками, рівняння рівноваги горизонтальних сил та 

моментів. Метод аналогічний методу Спенсера, окрім функції 

співвідношення між зсуваючими та утримуючими силами взаємодії між 

відсіками, яка має різні напрямки в кожному блоці (функція напів-синуса) 

(рис. 27).  

Додаткову інформацію щодо методів розрахунку стійкості укосу на 

ПК GeoStudio: Slope/W можливо прочитати [10, 11] та подивитись на 

Youtube SLOPE/W Session 1: SLOPE/W fundamentals : 

https://Www.youtube.com /Watch?v=sjNFUtyvLF8. 

 

 
Рис. 27. Розподіл сил за методом Моргенстена-Прайса 

 

Модель Кулона-Мора 

Розрахунки стійкості засновані на концепції граничної рівноваги. 

Спочатку обирається поверхня ковзання, в якій виникає граничний стан, 

що, за теорією Кулона-Мора, описується рівнянням: 

𝜏 = 𝑐 + 𝜎𝑛𝑡𝑎𝑛𝜑  ,      (24) 

де τ – сила зсуву (дотичні напруження), кПа; с – зчеплення, кПа;  σn – 

нормальні напруження, кПа; φ – кут внутрішнього тертя, град. 

Таким чином опір зсуву ґрунту складається з опору тертя, 

пропорційного нормальному тиску, плюс зчеплення між частинками 

ґрунту. 

Крива ковзання 

Основною задачею розрахунку стійкості укосу є визначення 

мінімального коефіцієнту стійкості найнебезпечнішої кривої ковзання. 
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Задати поверхні ковзання в ПК  GeoStudio: Slope/W можливо декількома 

способами: 

 за допомогою площі центрів ковзання  та радіусів циліндричних 

кривих (Grid and radius for circular slips); 

 поверхні ковзання формуються за допомогою вхідної і вихідної 

ділянок (Entry and exit specification). 

Визначення площі центрів ковзання та радіусів циліндричних кривих 

(Grid and radius for circular slips). 

Площа центрів ковзання задається координатами крайніх точок і 

розбивається сіткою на вузли, які є центрами ковзання. Радіуси кривих 

ковзання задаються лініями, дотичними до кривих ковзання (рис. 28). 

 
Рис. 28. Визначення площі центрів та радіусів кривих ковзання: 

1 – площа центрів кривих ковзання; 2 – дотичні до радіусів ковзання; 3 – центри кривих 

ковзання у вузлах сітки 

Крім дотичних, для радіусів ковзання можливо задавати одну точку, 

крізь яку будуть проходити всі криві ковзання, або задавати ряд точок для 

кривих ковзання (рис. 29). 

 
Рис. 29. Призначення радіусу кривих ковзання точками 
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Площину центрів ковзання також можливо замінити на одну точку, 

цей спосіб використовується, якщо необхідно визначити коефіцієнт 

стійкості для певної точки. 

Поверхні ковзання формуються за допомогою вхідної і вихідної 

ділянок (Entry and exit specification). 

Визначення координат поверхні центрів ковзання та радіусів  

ковзання – класичний метод розрахунку, інколи викликає ускладнення. 

Метод визначення положення кривих ковзання  за вхідною та вихідною 

ділянкою значно простіший. Згідно з цим методом визначається крива з 

точками входу кривих ковзання та крива з точками виходу кривих 

ковзання (рис. 30).  

 
Рис. 30. Метод – вхідна і вихідна ділянки 

 

Додаткову інформацію щодо визначення поверхні ковзання  на ПК 

GeoStudio: Slope/W можливо прочитати [10, 11] та подивитись на Youtube 

SLOPE/W 4: Trial Slip Surfaces: https://www.youtube.com/Watch?v= 

u3sv4JrWjBU&t=727s. 

Врахування насиченого водою ґрунту 

Поровий тиск визначається положенням п’єзометричної лінії, яка або 

задається за допомогою графічного редактора, або використовується 

попередній розрахунок кривої фільтрації в ПК Seep/W. Додаткову 

інформацію можна отримати з сайту GeoStudio та за посиланням SLOPE/W 

Session 5: Pore-water pressure conditions:  

 https://Www.youtube.com/Watch?v=EnQxOtaaDGk&t=837s. 

https://www.youtube.com/Watch?v=%20u3sv4JrWjBU&t=727s
https://www.youtube.com/Watch?v=%20u3sv4JrWjBU&t=727s
https://www.youtube.com/watch?v=EnQxOtaaDGk&t=837s
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4. Вимоги щодо розрахунків стійкості укосу ґрунтової греблі згідно з 

нормативними документами України 

Розрахунки стійкості укосів тіла греблі необхідно виконувати для 

круглоциліндричних поверхонь зсуву. Стійкість укосу повинна бути 

перевірена за можливими поверхнями зсуву з виявленням найбільш 

небезпечної поверхні з мінімальним коефіцієнтом стійкості. Під час 

розрахунків стійкості укосів греблі необхідно розглядати такі випадки: 

Для низового укосу: 

1. Рівень води в верхньому б’єфі відповідає НПР, в тілі греблі 

усталена фільтрація, в нижньому – максимально можливий рівень води за 

НПР (основний випадок). 

2. Рівень води в верхньому б’єфі НПР (водоскид без затворів), в 

нижньому – максимально можливий за розрахункової витрати. 

3. Рівень води в верхньому б’єфі – ФПР, в нижньому – максимально 

можливий за перевірочної витрати (особливий). 

Для верхового укосу: 

4. Максимально можливе пониження рівня води в водосховищі від 

НПР, неусталена фільтрація (основний). 

5. Рівень води в верхньому б’єфі перебуває на самій низькій відмітці, 

але не нижче 0,2h (висота відкосу), усталена фільтрація (будівельний 

випадок). 

6. Максимально можливе пониження рівня води в водосховищі від 

ФПР, неусталена фільтрація (особливий). 

Лабораторна робота 3. Визначення коефіцієнту стійкості низового 

укосу греблі для основного та перевірочного випадків 

Студентська ліцензія не включає неусталену фільтрацію, тому в 

лабораторній роботі розраховується тільки випадки 1 (2) та 3 для низового 

укосу греблі.  

Послідовність розрахунку стійкості укосу на ПК Slope/W 

Розрахунок стійкості укосу виконується на основі розрахунку кривої 

фільтрації в ПК Seep/W.  

Відкриваємо існуючий файл з розрахунком кривої фільтрації Seep/W 

(кнопка Open) (рис. 31). Додаємо аналіз стійкості укосу за допомогою 

кнопки Add. Обираємо тип аналізу Slope/W Analysis→Limit Equilibrium 

(рис. 32). Призначаємо тип аналізу, наприклад, метод Моргенстена-

Прайса, функція – напів-синус (Half-Sine), положення п’єзометричної 
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кривої (PWP Condition from): з попереднього розрахунку (Parent Analysis) 

(рис. 33). 

 
Рис. 31. Стартове вікно ПК GeoStudio 

 

 
Рис. 32. Визначення типу аналізу 
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Рис. 33. Визначення методу розрахунку стійкості укосу 

 

Призначаємо тип кривої ковзання (Slip Surface): напрямок руху 

(Direction of movement) – зліва направо (Left to Right); визначення кривої 

ковзання (Slip Surface Option): Сітка і радіус (Grid and Radius) (рис. 34).  

 
Рис. 34. Визначення кривої ковзання 

 

Додаємо за необхідності шар ґрунту основи за послідовністю 

описаною в розділі фільтраційні розрахунки за допомогою Меню Draw → 

Regions. Основа є насиченою водою (Saturated only). Виконуємо 

розрахунок кривої фільтрації для греблі з основою.  

Переходимо до другого розрахунку «Стійкість укосу».  Визначаємо 

матеріал тіла греблі та основи: меню Define → Materials, призначаємо для 

існуючих матеріалів тіла греблі та основи параметри для розрахунку 

стійкості укосу: модель Кулона-Мора, питома вага  (γ=ρg), зчеплення та 

кут внутрішнього тертя (рис. 35). Призначаємо матеріал тіла та основи 

греблі в меню Draw → Materials. 

Задаємо площину центрів кривих ковзання за допомогою Меню  

Draw→Slip Surface→Grid. Малюємо площину, починаючи з верхнього 

лівого краю, потім нижній лівий край і розтягуємо праворуч, кількість 

клітинок задаємо у спливаючому вікні. За необхідності можливо задати 

один центр ковзання: три кліки в обраній точці. 
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Рис. 35. Призначення параметрів ґрунтів 

 

Радіуси кривих ковзання можна задавати: 

 дотичними до кривих ковзання: Draw →Slip Surface→Radius. 

Малюємо множину дотичних до кривих ковзання, починаючи з верхнього 

лівого краю, далі праворуч → вниз та ліворуч замикаємо множину 

дотичних. Кількість дотичних визначаємо у спливаючому вікні (рис. 36); 

 множиною точок: Draw →Slip Surface→Radius. Малюємо пряму 

знизу вгору→ подвійний клік → вниз до початку прямої, кількість точок 

задаємо у спливаючому вікні. 

Однією точкою: Draw →Slip Surface→Radius. Чотири рази клікаємо в 

точці, крізь яку необхідно провести криву ковзання. 

Проводимо розрахунок стійкості укосу. 

Додаткова відеоінформація: 

https://Www.youtube.com/Watch?v=BE1ZaaBemwc&t=71s. 

Відеоприклад розрахунку стійкості укосу наведений за посиланням: 

https://drive.google.com/open?id=1eusrF4vF89jnfV1yJEh3SumRRSlFjlgP. 

 

https://www.youtube.com/watch?v=BE1ZaaBemwc&t=71s
https://drive.google.com/open?id=1eusrF4vF89jnfV1yJEh3SumRRSlFjlgP
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Рис. 36. Призначення центрів та радіусів кривих ковзання 

 

Аналіз результатів розрахунків 

У результаті розрахунку стійкості укосу отримаємо: 

1 – мінімальне значення коефіцієнту стійкості укосу; 2 – контур 

кривої ковзання з мінімальним коефіцієнтом стійкості; 3 – значення 

коефіцієнтів стійкості в кожному вузлі площини та контури коефіцієнтів 

стійкості; 4 – контури площин ковзання; 5 – розрахункові відсіки (рис. 37). 

 
Рис. 37. Відображення результатів розрахунку 
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Задати параметри площини центрів ковзання та легенду можливо за 

допомогою Draw Slip Surface Color Map (рис. 38). 

 
Рис. 38. Параметри площини центрів ковзання 

 

Якщо коефіцієнти стійкості укосу площин ковзання менше 

допустимого значення, необхідно збільшити укіс та повторити розрахунок 

фільтрації та стійкості укосу для нових параметрів греблі.  

Відеоаналіз розрахунку стійкості укосу наведено за посиланням: 

https://drive.google.com/open?id=1e7XMZWQ-hwYreYWMfY2W1lt8LZ-

w_mck. 

5. Теоретичні основи розрахунку осідання греблі 

Розрахунок переміщень, в тому числі і вертикальних (осідання), в ПК 

Sigma/W оснований на методі скінченних елементів. Залежність між 

деформаціями та напругами в проекціях на осі x, y, z описується системою 

рівнянь: 

𝜀х =
1

𝐸
[𝜎𝑥 − 𝜈𝜎𝑦 − 𝜈𝜎𝑧] ,     (25) 

𝜀𝑦 =
1

𝐸
[𝜎𝑦 − 𝜈𝜎𝑧 − 𝜈𝜎𝑥],    (26) 

𝜀𝑧 =
1

𝐸
[𝜎𝑧 − 𝜈𝜎𝑥 − 𝜈𝜎𝑦].    (27) 

де 𝜀 – деформації, м, 𝜎 – напруження, Па , Е – модуль Юнга, Па, 𝜈 – 

коефіцієнт Пуассона. 

Деформація зсуву визначається як співвідношення дотичних 

напружень до модуля пружності: 

𝜆𝑥𝑦 =
𝜏𝑥𝑦

𝐺
,   𝜆𝑦𝑧 =

𝜏𝑦𝑧

𝐺
,    𝜆𝑧𝑥 =

𝜏𝑧𝑥

𝐺
,     (28) 

https://drive.google.com/open?id=1e7XMZWQ-hwYreYWMfY2W1lt8LZ-w_mck
https://drive.google.com/open?id=1e7XMZWQ-hwYreYWMfY2W1lt8LZ-w_mck
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де 𝜆 – деформація зсуву;  𝜏 – дотичні напруження, Па; 𝐺 – модуль 

пружності, Па. 

Модуль пружності визначається за формулою: 

𝐺 =
𝐸

2(1+𝜈)
.      (29) 

У розрахунках допускаються деякі спрощення: нехтують 

напруженнями та деформаціями в напрямку z, отже 𝜀𝑧 = 0, 𝜆𝑦𝑧 = 0, 

𝜆𝑧𝑥 = 0. 

6. Вимоги щодо розрахунків осідання ґрунтової греблі згідно з 

нормативними документами України 

Розрахунок осадження тіла та основи греблі необхідно виконувати для 

визначення будівельного підйому, а також для уточнення об’ємів робіт 

щодо споруди. Розрахунок осадження греблі варто виконувати в кожному 

характерному перерізі (максимальний переріз, в області ядра, екрана, 

призми). 

Лабораторна робота 4. Визначення вертикальних деформацій 

(осідання) греблі та основи 

Студентська версія програми Sigma/W  дозволяє одночасно 

виконувати розрахунки тільки двох етапів в одному файлі, тому в 

лабораторній роботі ми виконаємо осідання греблі і основи без врахування 

послідовного будівництва греблі як одномоментний процес. На практиці 

необхідно розраховувати деформацію споруди впродовж будівництва, 

задаючи час укладання кожного шару споруди до повної висоти. З 

пошаровим визначенням осадження (вертикальних деформацій) греблі 

можна ознайомитися самостійно на сайті https://Www.geoslope.com/learning 

/support-resources/example-files/example?id=examples:sigmaw:embankmenton 

geosynthetic&resourceVersion=23.1.0.00000 та на відео: https://www.youtube. 

com/Watch?v=4q2KjLIz1yI&list=PL-8edcGmfy3JnXJ1pCjGritocIc1Xh94l& 

index=4&ab_channel=GeoStudioGeotechnicalAnalysis. 

Послідовність розрахунку осідання на ПК Sigma/W 

Відкриваємо студентську версію GeoStudio, створюємо новий файл 

формату А4, за допомогою Add обираємо геометрію 2D та додаємо Add   

Sigma/W Analysis – In Situ (початкові умови стійкості), Analysis Type: In 

Situ. Для створення початкових умов та розрахунку початкового порового 

тиску від рівня ґрунтових вод в Initial PWP Conditions from обираємо Water 

Table (рис. 39). 

https://www.geoslope.com/learning%20/support-resources/example-files/example?id=examples:sigmaw:embankmenton%20geosynthetic&resourceVersion=23.1.0.00000
https://www.geoslope.com/learning%20/support-resources/example-files/example?id=examples:sigmaw:embankmenton%20geosynthetic&resourceVersion=23.1.0.00000
https://www.geoslope.com/learning%20/support-resources/example-files/example?id=examples:sigmaw:embankmenton%20geosynthetic&resourceVersion=23.1.0.00000
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Рис. 39. Створення першого розрахункового випадку In situ 

 

Створюємо другий розрахунковий випадок, а саме: розрахунок 

деформацій (осадження). За допомогою кнопки Add додаємо аналіз 

навантаження/деформації Sigma/W – Load/Deformation. Для цього аналізу 

Parent – In Situ, Analysis Type: Load/Deformation. Initial Stress Condition: 

Parent Analysis, Initial PWP Conditions from: None (оскільки поровий тиск 

від ґрунтових вод встановлений під час In Situ) (рис. 40).  

 
Рис. 40. Створення розрахунку напружено-деформаційного стану греблі 

 

Створюємо геометричну модель греблі з основою (потужність основи 

повинна бути в двічі більша за висоту греблі). Створення геометричної 

моделі аналогічно описаному в розділі фільтраційний розрахунок. 

Призначаємо властивості ґрунтів для тіла греблі та основи за 

допомогою кнопки Define – Materials додаємо Add матеріал основи та 

греблі, Material Category: Effective-Drained  Parameters (цей тип моделі 

використовується для матеріалів, які добре дренують воду), Material 

Model: Linear Elastic. Для моделі лінійної деформації для визначення 

моделі ґрунту необхідно задати Модуль пружності, питому вагу ґрунту та 

коефіцієнт Пуассона (рис. 41).   
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Рис. 41. Створення властивостей ґрунтів основи та тіла греблі 

 

На стадії розрахунку In Situ задаємо тільки ґрунт основи, бо ми 

моделюємо початкові умови до будівництва греблі за допомогою кнопки 

Draw – Materials, вибираємо основу та клікаємо на геометрію основи 

(аналогічно фільтраційному розрахунку).  

Задаємо рівень ґрунтових вод: Draw – Initial Water Table, вказуємо 

рівень води в метрах від початку координат (на рис. 42 рівень води 1,5 м 

вище нульової відмітки, яка співпадає з верхом основи).  

Створюємо граничні умови: обмеження переміщень для основи: 

Define – Boundary Condition, обмеження переміщень нижньої частини 

основи визначається обмеженнями переміщень по осі x та y, бічні поверхні 

основи обмежуються тільки по осі x, Kind: Force/Displasment. Призначення 

граничних умов щодо обмеження переміщень виконується за допомогою 

команди Draw – Boundary Condition, обираємо необхідну граничну умову, 

select: line, виділяємо необхідну межу основи (рис. 43).  
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Рис. 42. Створення рівня ґрунтових вод Water Table 

 

 
Рис. 43. Створення граничної умови обмеження переміщень 

 

Розраховуємо аналіз In situ: переходимо у вкладку Solve Manager, 

виділяємо початкові умови In Situ пташкою і натискаємо Start, 

розраховуємо напружено-деформований стан основи без греблі.  

Переходимо до другого розрахункового випадку: визначення НДС 

греблі з основою. Призначаємо ґрунт для тіла греблі Draw – Materials.  

У якості тренування призначимо граничну умову – рівномірне 

навантаження на гребінь греблі. Створюємо граничну умову навантежння: 

Define – Boundary Condition. Kind: X-Y Stress, Y-Stress: Constant -15 кПа 

(знак мінус показує напрямок навантаження по осі Y). 
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Призначаємо граничну умову навантаження на лінійну поверхню 

Lines у вкладці Draw – Boundary Condition (рис. 44). 

 
Рис. 44. Призначення рівномірного навантаження на гребінь греблі 

 

Розраховуємо другий випадок  Load/Deformation: переходимо у 

вкладку Solve Manager, виділяємо Load/Deformation пташкою і натискаємо 

Start, розраховуємо напружено-деформований стан греблі з основою.  

Аналіз результатів розрахунків 

У результаті розрахунку напружено-деформованого стану греблі та 

основи ми отримаємо: сітку деформацій; значення та зміну вертикальних 

переміщень (displacement) вздовж геометричної лінії (поверхня основи, 

гребінь) та вздовж вертикальної осі греблі. 

Відображення сітки деформацій задається у вкладці Results-Draw – 

Vectors або іконка-сітка на панелі інструментів. У вікні Draw Vectors 

можна задати розмір векторів, колір сітки, масштаб Magnification, який 

дозволяє збільшити деформації для візуалізації (рис. 45).    

 
Рис. 45. Сітка деформацій 
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Значення вертикальних переміщень (осадження) вздовж геометричної 

лінії можна визначити за допомогою графіка: Draw – Graph або іконка 

Graph (рис. 46), додаємо Add графік осадження, визначення геометричної 

лінії Set Locations – Geometry Item та обираємо геометричну лінію (в 

прикладі обрана поверхня основи, натискаємо Show Grap. Вид змінної 

Displacement:  

Y-Displacement (вертикальні), vs.: по осі Х Distance, виділяємо другий 

розрахунковий випадок (рис. 46). Як видно з графіка (рис. 46) максимальні 

переміщення основи складають 0,068 м по осі греблі.   

Вертикальні переміщення та їх зміна вздовж вертикальної лінії (осі 

греблі) визначається за графіком аналогічно попередньому випадку, тільки 

Set location: Custom Location, виділяємо вздовж осі греблі вузли, 

натискаємо Show Graph.  Вид змінної Displacement: Y-Displacement 

(вертикальні), vs.: Y, виділяємо другий розрахунковий випадок (рис. 47). 

Як видно з графіка (рис. 47), максимальні переміщення мають місце на 

гребні і  складають  

0,1 м.  

 
Рис. 46. Визначення переміщень (осадження) вздовж геометричної лінії 
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Рис. 47. Зміна вертикальних переміщень вздовж осі греблі 
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